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鋼構 SRC 複合構架設計範例 

 

案例簡介 

 

 
 

三維廠房模型示意圖 

 

  

 

建物基本資料： 

 座落位置：假設本結構物基地座落於高雄縣仁武鄉某廠區 

 樓 層 數：地上兩層之結構物 

 結構系統：本廠房 X 向構架採用同心斜撐系統(SCBF)；Y 向構架採用韌性抗彎矩構

架系統(SMRF)。 

 結構形式：主體結構採鋼骨構造加鋼骨鋼筋混凝土柱構造，樓版採用鋼承版系統。 

 用途係數：重要建築物 (I=1.5) 

 地盤種類：第三類地盤 
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材料： 

 鋼材：SM400 (fy=2500 kg/cm2) 

 混凝土強度：C280 (fc’=280 kg/cm2) 

 主筋：SD420 (fy=4200 kg/cm2) 

 剪力筋：SD280 (fy=2800 kg/cm2) 

 

斷面尺寸： 

  

名  稱 斷面號 混凝土斷面尺寸 型鋼斷面 備註 

SC1 1 - RH 394x398x11x18 鋼柱 

SSC1 2 55 x 55 cm RH 300x300x10x15 SRC 柱 

2SG1 11 - RH 506x201x11x19 大梁 

2SB1 12 - RH 300x150x6.5x9 大梁 

2Sb1 13 - RH 294x200x8x12 小梁 

RSG1 21 - RH 450x200x9x14 大梁 

RSG2 22 - RH 588x300x12x20 大梁 

RSB1 23 - RH 300x150x6.5x9 大梁 

RSB2 24 - RH 350x175x7x11 大梁 

RSb1 25 - RH 294x200x8x12 小梁 

RSb2 26 - RH 400x200x8x13 小梁 

RSb3 27 - RH 300x150x6.5x9 小梁 

VB1 31 - CT 175x350x12x19 斜撐 

 

載重狀況： 

  

 本案假設考慮之載重資料如下： 

 靜載重(DL)：結構體自重，樓版載重 2FL = 460 kg/㎡ , RF = 470 kg/㎡ 

   屋頂女兒牆重 350 kg/m (12cm 厚，高 1.2m) 

 活載重(LL)：樓版載重 2FL = 300 kg/㎡ , RF = 270 kg/㎡ 

   屋頂 RSb3 梁上吊掛物重量 120 kg 

 風力(WX)： 迎風面 120 kg/m , 背風面 55 kg/m 

 風力(WY)： 迎風面 110 kg/m , 背風面 50 kg/m 

 地震力(EXn, EXp, EYn, EYp)：依建築物耐震設計規範輸入 X,Y 向設計地震力並 

                  考慮 5%意外扭矩之分析計算 
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操作流程 

1. 指定單位與定義材料和斷面 

首先點擊 Windows 桌面上的 midas Gen 程式捷徑  或由程式集目錄開啟程式。 

(1) 從主選單選取 File > New Project 或在圖示選單中按一下  New 建立新檔案。 

(2) 從主選單選取 Tools > Unit System 設定長度單位為 m，力量單位為 kgf。 

 

(3) 定義材料：從主選單中選取 Properties >  Material Property  

 

 
 

- 按 Properties 對話框內  增加材料性質。 
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- 首先定義鋼構材料性質(Material ID=1)：在 Type of Design 選 Steel，在 Steel > DB 欄

位選擇 SM400 後按 。 

- 接著定義 SRC 材料性質(Material ID=2)：在 Name 欄位輸入 SM400+C280，在 Type 

of Design 選 SRC，在 Steel > DB 欄位選擇 SM400 ，在 Concrete > DB 欄位選擇 C280

後按 。 

  

 

- Properties 對話框內顯示兩筆材料性質資訊，如下圖所示。 
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(4) 定義斷面：由 Properties 對話框切換到 Section 表單，按  增加斷面性質。 

 

- 首先定義鋼柱斷面(Section ID=1)：在 DB/User 表單的 Name 欄位輸入 SC1 名稱，斷

面形狀選擇  ，輸入方式為 DB > CNS91 型鋼資料庫，由 Sect. Name 列

表選擇斷面 RH 394x398x11x18 後按 。 

 

接著定義 SRC 柱斷面(Section ID=2)，SRC 斷面需分別指定混凝土斷面尺寸與鋼構斷面，

並給定轉換等值鋼材性質的材料資訊。 

- 切換到 SRC 表單，在 Name 欄位輸入 SSC1 名稱，斷面形狀選擇  。 
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- Concrete Data 的 HC = 0.55m , BC = 0.55 m，Steel Data 則由 Sect. Name 列表選擇斷

面 RH 300x300x10x15。 

- 按 Material 區域內的  鍵開啟定義混凝土與鋼構材質的對

話框，Concrete Material 選 CNS560(RC): C280，Steel Material 選擇 CNS06(S): SM400

按  關閉回到 Section Data 對話框，按  加入此斷面。 

      

- 定義鋼梁斷面：切換到 DB/User 表單，Section ID 欄位輸入編號 11，Name 欄位輸入

2SG1，斷面形狀選 ，選擇斷面 RH 506x201x11x19 按  加入。 

- 重複上個步驟，逐一加入所有 H 型鋼斷面(Section ID=12,13,21~27)。 
 

名  稱 斷面號 型鋼斷面 

2SG1 11 RH 506x201x11x19 

2SB1 12 RH 300x150x6.5x9 

2Sb1 13 RH 294x200x8x12 

RSG1 21 RH 450x200x9x14 

RSG2 22 RH 588x300x12x20 

RSB1 23 RH 300x150x6.5x9 

RSB2 24 RH 350x175x7x11 

RSb1 25 RH 294x200x8x12 

RSb2 26 RH 400x200x8x13 

RSb3 27 RH 300x150x6.5x9 

VB1 31 CT 175x350x12x19 
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- 最後 Section ID 欄位輸入編號 31，Name 欄位輸入 VB1，斷面形狀選 ，

選擇斷面 CT 175x350x12x19 按  加入。 

 

- 所有的斷面資料建立後，Properties 對話框顯示如下圖，按  關閉。 
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2. 建立幾何模型 

利用各種方便的建模功能快速建立三維幾何分析模型。首先利用 Line Grid 軸網功能先建立柱

線之 X-Z 立面構架，再利用 Create/Translate Elements 新增/複製功能建立其他構架上的構件，

再配合修改構件之斷面性質資料，完成整體分析模型的建立。 

 

定 UCS 平面與軸網設定：預設的軸網平面為 X-Y 平面，為了方便在 X-Z 立面上建立柱線構

架桿件，我們先將 UCS 平面設定在 X-Z 面上。 

(1) 從主選單選取 Structure > UCS > X-Z Plane  

(2) Plane 建立原點為座標 (0, 0, 0) 的 UCS 平面。 

- 確認 Coordinates > Origin 為“ 0, 0, 0 ”。 

-  勾選 “Change View Direction” 項目後，按 。 

 

(3) 從主選單選取 Structure > Grids > Define Line Grid 建立軸網資料。 

- 按  增加新的軸網設定。 

 
 

- 在 Grid Name 輸入“ Line-1”。按 X-Grid Lines 與 Y-Grid Lines 區域內的  分

別設定網格資料。 
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- X 向 Grid Lines 輸入 “ 6, 2 @ 6.5, 5.5, 7 ” 按 。 

 

- Y 向 Grid Lines 輸入 “ 4.8, 3.6 ” 按 。 

 

- 按 Add/Modify Grid Lines 與 Define Grids 對話框的  。按右側視景控制工

具列上的  Fit 顯示全景，設定的軸網格將顯示於模型視窗上。 
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運用  Create Elements 功能建立柱線構架上的柱、梁、斜撐構件。 

(4) 從主選單中選取 Node/ Elements >  Create Elements 功能。 

- 建立鋼柱：在 Material 選“ 1:SM400 ”，Section 選 “ 1:SC1 ” 

- 型鋼擺向設定：Orientation > Beta Angle 選“ 90° ”   

- 移動滑鼠遊標到 Nodal Connectivity 欄位內，該欄位底色變草綠色後在模型視窗上點

擊第 1 個點(0, 0, 0)與第 2 個點(0, 0, 8.4)連成第 1 根柱構件(柱 A)。 

 

   

 

 

 

 

UCS 

 

 

第 1 點 (0, 0, 0) 

第1 根柱構件

第 2 點 (0, 0, 8.4) 

柱 A 
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- 將  Node number 與  Element number 打開方便檢視節點與構件編號。 

- 依相同的材料、斷面建立如下圖所示的柱 B、柱 F 構件。 

 

 

 

 

- 建立 SRC 柱：在 Material 選 “ 2:SM400+C280 ”，Section 選 “ 2:SSC1 ” 

- 型鋼擺向設定：Orientation > Beta Angle 為“ 90° ” 

- 同樣利用 Nodal Connectivity 欄位用滑鼠點選格網交叉點快速建立如下圖所示的柱 C、

柱 D、柱 E。 

 

 

 

 

 

 

柱 B                                     柱 F 

柱 C      柱 D     柱 E 
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- 建立 2F 鋼梁：在 Material 選 “ 1:SM400 ”，Section 選 “ 12:2SB1 ” 

- 型鋼擺向設定：Orientation > Beta Angle 為“ 0° ” 

- 建立 2F 的大梁(如下圖所示)。 

 

 

 

 

- 建立 RF 鋼梁：Section 選 “ 23:RSB1 ”，建立 RF 層柱 A~柱 E 間的大梁。 

- 接著，Section 選 “ 24:RSB2 ”，建立 RF 層柱 E~柱 F 間的大梁(如下圖所示)。 

 

 

 

 

 

 

 

 

RSB1                   RSB2    

2SB1  
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- 建立斜撐：Section 選 “ 31:VB1 ”，同法建立斜撐構件完成柱線構架(如下圖)。 

- 按  關閉此功能。 

 

 

 

- 按工具列右上  Line Grid 關閉軸網格線 

- 由 View > UCS/GCS 切換回 GCS 整體座標系，並將模型視景切換為  Iso View。 

   

- 將  Node number 與  Element number 關閉節點與構件編號。 
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(5) 運用  Translate Elements 功能建立柱線、構架的構件。 

- 滑鼠雙擊(左鍵點兩下)工作樹 Section 選單上斷面 “1 : SC1” 選取所有的 SC1 柱構

件。 

 

 

 

- 選取主選單 Node/Elements >  Translate Elements 移動複製功能 

- Mode 選 Copy 複製 

- 在 Translation 區域內 Equal Distance > dx, dy, dz 輸入 “0, 6.2, 0” m 

- Number of Times > “1” 次，按  建立柱線的 SC1 柱構件 

-  AutoFit 顯示全景如下圖 
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- 用  Select by Plane 平面選取功能開啟 Plane & Volume Select 對話框 

- 選擇 “XZ Plane” 選項，Y Position > “ 0 ” m 選取柱線構架。 

-  關閉此功能 

 

 

 

- 會到右邊 Translate Elements 功能對話框，Mode 選 Copy 複製 

- 在 Translation 區域內 Equal Distance > dx, dy, dz 輸入 “0, 12.2, 0” m 

- Number of Times > “1” 次，按  建立柱線的所有構件 

-  Fit 顯示全景如下圖 
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運用  Create Elements 功能建立 Y 向的大梁構件。 

(6) 從主選單中選取 Node/Elements >  Create Elements 功能。 

- 在 Material 選 “ 1:SM400 ”，Section 選 “ 11:2SG1 ” 

- 利用 Nodal Connectivity 欄位用滑鼠點選節點建立 2F 的 Y 向大梁(如下圖) 

 

 

 

 

- Section 選 “ 21:RSG1 ”，建立 RF 層柱線 A, B, F 的 Y 向大梁 

- Section 選“ 22:RSG2 ”，建立 RF 層的柱線 C, D, E 的 Y 向大梁 

- 完成圖如下 
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(7) 運用  Translate Elements 移動複製功能建立柱線 A-B 間的小梁構件。 

- 用  Select Single 單選功能選取構件編號 7 的 2SB1(參考下圖)。 

- 選 Node/Element 工具列上  Translate 功能，Mode 選 Copy 複製 

- 在 Translation 區域內選 Unequal Distance， Axis > “ y ” 

- Distance 輸入 “ 4@1.55 , 3@1.5 ” m 

- 斷面號增量 Section Inc. > “1”，勾選 Intersect 的 “Node”、“Elem” 交叉斷點選項 

- 按  建立 2F 所有 2Sb1 小梁構件。 

 

 

 

- 用  Select Single 單選功能選取構件編號 18 的 RSB1(參考下圖)。 

- 在 Translation 區域的 Distance 輸入“ 2.5 , 1.5, 2.2, 2, 1.5 ” m 

- 斷面號增量 Section Inc. > “2”，按  建立 RF 層所有 RSb1 小梁構件。 

 

 

 

 

2SB1 (7)  
 斷面號增量 

(Section Inc.) 
 
斷面 13: 2Sb1 
斷面 12: 2SB1 
增量=13-12=1 

RSB1 (18) 

 
 斷面號增量 

(Section Inc.) 
 
斷面 25: RSb1 
斷面 23: RSB1 
增量=25-23=2 
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- 用  Select by Plane 平面選取功能，選擇 “XY Plane” 選項，Z Position > “ 8.4 ” m

選取 RF 層，按  關閉。 

 

 

 

 

- 按工具列上的  Activate 功能並切換視景到  Top View 顯示 RF 層平面如下

圖。 
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(8) 接著用  Create Elements 功能建立 RF 層柱線 B~F 的 RSb2 與 RSb3 小梁構件。 

- 在 Material 選 “ 1:SM400 ”，Section 選 “ 26:RSb2 ” 

- 勾選 Nodal Connectivity 欄位後的 “ Ortho ”正交選項，用滑鼠點選節點建立 RF 層 X

向的 RSb2 小梁(如下圖)。 

 

 

 

 

- 在 Section 選“ 27:RSb3 ”，用滑鼠點選構件中點建立 RF 層 Y 向的 RSb3 小梁(如下圖)。 

 

 

 

 

 

 

RSb2  

RSb3 
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三維幾何模型已完成，點擊工具列上  Activate All 啟用全部模型並切換視景到  Iso 

View 檢視目前的三維構架。 

(9) 點擊工具列上  切換到 Works 表單查看模型的各項資訊。 

 

 

(10)  由主選單 Structure> Control Data> Story 指令建立樓層資料並定義樓版為剛性隔板。 

- 按 Story Data 對話框內的  鍵。在右邊 Selected List 欄位內

保留 Level > “0, 4.8, 8.4” 三筆資料，其餘歸到 Unselected List 不選取，按  

加入樓層設定資料。 
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- 樓層資料表內顯示樓層名稱與高程，及考慮設定為剛性隔板等資訊，草綠色的欄位都

是可編輯的欄位，可嘗試變更樓層名稱。 

 

 

 

- 由程式自動計算的 5%偏心可由 Story Data 對話框內的 Seismic 表單內查詢。 

 

 

 

- 按  關閉 Story Data 對話框回到主視窗，按工具列上  Display Story 

Numbers 即可將樓層名稱顯示於模型右側。 
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3. 定義邊界條件與梁端釋放 

先將模型結構體之自重(梁、柱、斜撐等構件重量)轉換為質量，查看程式計算的質心位置，另

針對 2F 挑空的樓板區域設定 Diaphragm Disconnect 條件後再次檢視 2F 與 RF 層的質心位

置。 

 

(1) 由主選單 Structure > Structure Type 指令將結構模型自重轉換為質量。 

- 在 Conversion of Structure Self-weight into Masses 區域內的“Lump Mass”選

“Convert to X, Y”轉換自重為 X, Y 向質量。 

-  勾選“Align Top of Beam Section with Floor (X-Y Plane) for Panel Zone Effect / 

Display”項目設定梁頂與樓版面對齊。   

 
 

- 點選工具列上  Display 顯示選項，切換到 Boundary 表單， 勾選“Story 

Diaphragm”選項查看剛隔板與目前質心的位置。 

 

 Story Diaphragm 查看質心位置 
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(2) 從主選單選取 Boundaries > Diaphragm Disconnect… 指令設定 2F 柱線 C~F 的所有節點

不連結剛性隔板。 

- 切換視景到  Front View，用  Select by Window 窗選功能由左而右圈選 2F 柱

線 C~F 的所有節點(如下圖)。 

- Option 選 “Add” 項目，按  加入不連結剛隔板的節點。 

 

 

 

- 切換視景到  Iso View 檢視更新的質心位置。 

 

 

 

- 點選工具列上  Display 顯示選項，取消勾選“Story Diaphragm”選項，關閉剛

隔板與質心的顯示。 
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接著利用 Beam End Release 指令指派梁端彎矩釋放條件模擬鉸接合。 

 

(3) 從主選單選取 Boundaries > Beam End Release 功能設定 Pined 接條件。 

- 點選工具列上  Display 顯示選項，切換到 Property 表單， 勾選“Property 

Name”選項查看斷面名稱。 

 

 

 

- 在工具列上點擊  Activate by identifying 功能開啟 Activate Identify 對話框，選

擇 Story 項目與 “ 2F”、“ Floor ” 選項後按   啟用 2F 平面。 
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- 開啟  Shrink Element 關閉  Hidden Surface 功能方便檢視 

- 切換視景到  Top View，用  Select by Window 選取柱線 A~B 間的 2Sb1 小梁

及柱線 B~E 間的 2SB1 大梁(如圖圈選之構件) 

- 梁兩端均為鉸接 ，按   指派。 

 

 

 

- 再次用  Activate by identifying 功能選擇 Story > “ Roof ”  啟用。 

- 用  Select by Window 選取柱線 A~B 間的 RSb1 小梁及柱線 B~E 間的 RSb2 小梁

及 RSb3 小梁(如圖圈選之構件) 

- 梁兩端均為鉸接 ，按  指派。 
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- 選取柱線 B~F 間的 RSb2 小梁，梁 I 端設為鉸接 ，按  指派。 

 

 

 

- 選取柱線 B~F 間的 RSb2 小梁，梁 J 端設為鉸接 ，按  指派。 

 

 

 判斷構件的 I、J 端：由  Display 顯示的 Element 表單勾選“Local Direction”選

項，顯示構件局部方向，( >> ) 箭號方向代表局部座標 x 軸方向，表示如下： 

 

 
I                       J 
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- 由  Display 顯示功能取消勾選“Property Name”選項，不顯示斷面名稱，RF

層梁端鉸接設定的情況如下圖所示。 

 

 

 

- 點擊工具列上  Activate All 啟用全部模型並切換視景到  Front View 方便選

取斜撐構件，依上述同樣的方法指派斜撐構件的  與  

條件，完成圖如下。 
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最後設定柱底為固定支承條件。 

 

(4) 從主選單 Boundaries > Supports 指令定義柱底為固定端支承。 

- 用  Select by Window (下圖中) 由左而右圈選柱底的節點(如下頁圖)。 

- 勾選“D-ALL”與“R-ALL”項目，按         指派邊界條件。 

 

 

 

切換視景到  Iso View 檢視整體模型，按  到 Works 表單檢視 Boundaries 項目

內各項已定義的邊界條件資訊。 
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4. 輸入各種載重 

本案考慮靜載重、活載重、風力與水平向地震力等 8 組載重情況(參考 P5 載重說明)。 

 

(1) 首先由主選單 Load > Static Load Cases 指令定義考慮的載重情況。 

- 在 Name 欄位輸入 “DL”、Type 選 “ Dead Load (D) ” 靜載重    

- 在 Name 欄位輸入 “LL”、Type 選 “ Live Load (L) ”  活載重   

- 在 Name 欄位輸入 “WX”、Type 選 “Wind Load on Structure (W) ” 風力   

- 在 Name 欄位輸入 “WY”、Type 選 “Wind Load on Structure (W) ” 風力  

- 在 Name 欄位輸入 “EXp”、Type 選 “Earthquake (E) ” 地震力    

- 如下圖依序加入“EXn”、 “EYp”、 “EYn” 等地震力載重狀況，按  關閉。 

 

 

(2) 由主選單 Load > Self Weight 指令輸入自重。 

- 在 Load Case Name 確定為 “ DL”、 Z 欄位輸入 “ -1 ” 按  加入。 
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先定義樓版載重形式(靜載重+活載重)，再用樓版載重功能指派作用的載重區域與分佈形式。 

 

(3) 由主選單 Load > Assign Floor Load > Define Floor Load Type 指令定義樓版載重形式。 

- 在 Name 欄位輸入 “ 2F”、 Load Case 與 Floor Load 輸入 “ DL：-460 ” kg/㎡ 與

“ LL：-300 ” kg/㎡ 後按  加入。 

- 在 Name 欄位輸入 “ RF”、 Load Case 與 Floor Load 輸入 “ DL：-470 ” kg/㎡ 與

“ LL：-270 ” kg/㎡ 後按  加入。 

-  關閉對話框。 

 

(4) 由主選單 Load > Assign Floor Load > Assign Floor Load 指令指派樓版載重。 

- 在 Load Type 選“2F”; Distribution 選“One Way”單向版分配。 

- 將滑鼠移到 Nodes Defining Loading Area 欄位(填草綠底色後)，在模型視窗上依序

點擊樓板之角隅節點 “ 33, 13, 15, 35, 33 ”指派載重作用範圍(如下圖所示)。 

 

 

 

33 

13 

15 

35 
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- 在 Load Type 選“RF”; Distribution 選“One Way”單向版分配。 

- 將滑鼠移到 Nodes Defining Loading Area 欄位(填草綠底色後)，在模型視窗上依序

點擊樓板之角隅節點 “ 44, 2, 6, 49, 44 ” 指派載重作用範圍(如下圖所示)。 

 

 

 

 

(5) 點擊工具列上  Initial View 清除畫面上顯示的樓板載重。 

由主選單 Load > Line Beam Loads 指令指派 RF 層的女兒牆載重。 

- 在 Load Case Name 選“DL”; 下方 Value 區域內“w”值輸入“-350”kg/m。 

- 將滑鼠移到 “Nodes for Loading Line” 欄位(填草綠底色後)，在模型視窗上依序點擊

角隅節點 2 – 6, 6 – 49, 49 – 44 , 44 – 2 等指派線載重於大梁上(如下圖所示)。 

 

 

 

 

 

44 
2 

6 

49 

44 
2 

6 
49 
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(6) 由主選單 Load > Element Beam Loads 指令指派 RF 層作用於 RSb3 小梁的集中活載重。 

- 利用  Select Single 功能選取 RF 層的 RSb3 小梁構件。 
- 在 Load Case Name 選“LL”; Load Type 選“Concentrated Forces” 

- Value 區域內 x1 值輸入“ 0.5 ”、P1 值輸入“-120”kg，按  指派。  

 

 

 

 

(7) 同樣利用 Load > Element Beam Loads 指令指派作用於構架上的風力載重。 

- 用  Select by Plane 功能選 YZ Plane；X Position > “ 0 ” m 選取柱線 A 構架。 
- 在 Load Case Name 選“WX”; Load Type 選“Uniform Loads” 

- Direction 選“Global X”; Value 區域內“w”值輸入“ 120 ”kg/m，按  指

派。  
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-  Select by Plane 功能選 YZ Plane；X Position > “ 31.5 ” m 選取柱線 F 構架。 
- Value 區域內“w”值輸入“ 55 ”kg/m，按  指派。  

 

 

 

 

-  Select by Plane 功能選 XZ Plane；Y Position > “ 0 ” m 選取柱線構架。 
- 在 Load Case Name 選“WY”; Direction 選“Global Y” 

- Value 區域內“w”值輸入“ 110 ”kg/m，按  指派。  
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-  Select by Plane 功能選 XZ Plane；Y Position > “ 12.2 ” m 選取柱線構架。 
- Value 區域內“w”值輸入“ 50 ”kg/m，按  指派。  

 

 

 

 

作用的靜載、活載及風力載重均已指派完成。在定義水平向地震力之前，需將外力載重(DL)

轉換為質量(結構自重轉換為質量先前已定義)，質量轉換後再定義地震力載重。 

 

(8) 由主選單 Load > Loads to Masses 指令將靜載重轉換為節點質量。 

- 在 Mass Direction 選“X, Y”; Load Case 選“DL”; Load Factor 輸入“1”按 

 加入。  
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(9) 由主選單 Load > Seismic Loads 指令定義 X 與 Y 向地震力載重。 

(參考下頁圖說) 

- 按 Static Seismic Loads 對話框的  開啟 Add/Modify Seismic Load 

Specification 對話框設定地震力載重相關參數。 

指定載重狀況與採用規範： 

- Load Case Name 選“EXp” (X 向地震載重+正扭矩) 

- Seismic Load Code 選“Taiwan(2011)”建築物耐震設計規範 

 

Seismic Load Parameters 震區相關參數設定： 

- Seismic Zone (Z) 選“General Zone”一般工址 ; 按  定義水平譜

加速度係數與地盤種類： 

-  Horizontal Spectral Accel.： 

  Short Period (Ss) > Design : 0.7   ;  Maximum : 0.9  

1 sec Period (S1) > Design : 0.35  ;  Maximum : 0.5 

-  Soil Type： Type 3      

- “Importance Factor (I)”選“1.5” 

- “Seismic Magnify Factor (αy)”輸入“1.0”值 

 

Structural Parameter 結構基本週期與結構系統相關參數設定： 

- 選擇 “Approximate Period” 按  按鍵定義週期計算 

- X Direction Period：採用 “3. T=0.050 Hn^(3/4)” 

- Y Direction Period：採用 “1. T=0.085 Hn^(3/4)” 

- Response Modification Coef. (R): 結構系統韌性容量 X-Dir > “3.6”；Y-Dir > “4.0” 

 

Seismic Load Direction Factor (Scale Factor) 橫力分配方向係數設定： 

- X 向地震力 X-Direction 輸入 “ 1 ”  ;  Y-Direction 輸入 “ 0 ”  

- Accidental Eccentricity 區域的 X-Direction (Ex):  “ Positive ” (考慮 5% 正扭矩) 

- 按        指派 EXp 設定 

 

查看豎向分配結果： 

- 按  按鍵可查看 Story Force, Story Shear , Overturning Moment。 

- 按  按鍵可查看程式對設計地震力計算的過程。 

 

 

回到 Add/Modify Seismic Load Specification 對話框繼續設定地震力載重 EXn： 

- Load Case Name 選“EXn” (X 向地震載重+負扭矩) 

- Accidental Eccentricity 區域的 X-Direction (Ex):  “ Negative ” (考慮 5% 負扭矩) 

- 按        指派 EXn 設定 
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水平譜加速度係數與地盤種類  

經驗公式週期  

水平橫力分配  

設計地震力計算結果  
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在 Add/Modify Seismic Load Specification 對話框繼續設定 Y 向地震力載重： 

- Load Case Name 選“EYp” (Y 向地震載重+正扭矩) 

- Y 向地震力 “X-Direction” 輸入 “ 0 ”  ;  “Y-Direction” 輸入 “ 1 ”  

- Accidental Eccentricity 區域的 Y-Direction (Ey):  “ Positive ” (考慮 5% 正扭矩) 

- 按        指派 EYp 設定 

 

- Load Case Name 選“EYn” (Y 向地震載重+負扭矩) 

- Accidental Eccentricity 區域的 Y-Direction (Ey):  “ Negative ” (考慮 5% 負扭矩) 

- 按  指派 EYn 設定 

- 按           關閉 Static Seismic Loads 對話框 

 

 
 

由 Works 表單選擇地震力載重項目按右鍵 Display 選項檢視橫力分配結果： 

 

 

 

透過 Works 表單選擇各項載重項目按右鍵 Display，可查看各載重施加的狀況。 
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5. 載重組合 

由主選單 Results >Load  Combinations 指令定義執行鋼構及 SRC 設計的載重組合。 

- 選擇 Steel Design 表單，按下方  開啟載重組合自動產生的

設定對話框。 

- 確認 “Steel > Design Code” 為 “TWN-LSD96” 後按  自動產生 52 組載

重組合。前 26 組(Strength)應力檢討，後 26 組(Serviceability)使用性撓度檢討用。 

 

 
 

 

 

 

 

 

 

- 切換到 SRC Design 表單，按下方  開啟載重組合自動產生

的設定對話框。 

- 確認 “SRC > Design Code” 為 “TWN-SRC100” 後按  自動產生 26 組載

重組合。  

- 按  關閉 Load Combinations 對話框。  
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6. 執行分析 

先設定考慮特徵值分析（模態分析）條件後執行分析。 

 

(1) 由主選單 Analysis > Eigenvalue Analysis Control 指令設定模態分析方法。 

- Eigen Vectors 區域內的 Number of Frequencies 設定 “10” 。  

 

(2) 由主選單 Analysis > Perform Analysis 或工具列上  Analysis(F5) 執行分析。 
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7. 查看分析結果 

執行完分析後，簡單介紹查看反力、位移、彎矩圖與模態分析等的圖表結果。 

 

(1) 由 Results > Result Table > Reaction 查看 DL 與 LL 載重下的反力輸出表。在反力結果表

格中提供各載重狀況/載重組合的反力總和結果。 

                       

 

(2) 由 Results > Deformation > Displacement Contour 查看各載重狀況/組合下的位移圖。 

- 在 Type of Display 勾選 “ Deform ” 與 “Legend ” 選項顯示變形與圖例。 

- 按  執行。 
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(3) 由 Results > Forces > Beam Diagram 查看各載重狀況/載重組合下的軸力/剪力/彎矩圖。 

- 在 Display Options 選擇 “ Solid Fill ”，在 Type of Display 勾選 “Legend ” 選項顯示

圖例，按  執行。 

 

 

 

(4) 由 Results > Result Tables > Vibration Mode Shapes 查看模態分析的結果表。 

- 在 Display Options 選擇 “ Solid Fill ”，在 Type of Display 勾選 “Legend ” 選項顯示

圖例，按  執行。 

 

 
 

- 動畫顯示功能：在 Type of Display 勾選 “Animate ” 選項，按  執行。 

- 按 Model View 視窗右下方的  Record 錄製動畫(如下圖)。 
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- 按 Model View 視窗右下方的  Save 可將錄製的動畫儲存為 AVI 檔案。 

- 按 Model View 視窗右下方的  Close 結束動畫顯示功能。 

 

(5) 由 Results > Result Tables > Vibration Mode Shapes 查看模態分析的結果表。 

 

 

 

週期  

各振態質量參與係數 
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8. 定義設計參數 

檢核完分析結果後，進入設計階段。先定義構架之側移條件、指派程式自動計算有效長度係

數 K 值的功能等基本的設計參數。 

 

(1) 由 Design > General Design Parameter > Definition of Frame 指令，將 X/Y-Direction of 

Frame 設定為 “Unbraced | Sway” 並勾選 “Auto Calculate Effective Length Factors” 

選項。 

   

 

 

(2) 由 Design > General Design Parameter >  Member Assignment… 指派設計桿件，此

功能係將被小梁切斷的數根大梁構件(Elements)組成一根完整的梁桿件(Member)進行設

計。 

- 在 Assign Type 選 “Automatic” ; Selection Type 選 “By Selection”，利用狀態列上過

濾器 “y ” 選取 Y 向大梁後，按工具列上  Select All 全選，點擊  指派。 
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- 利用選取(取消選取過濾功能“None”)與指派的動作完成其他分割構件的組合桿件，如

RF 層的 RSb2 小梁及立面的斜撐構件。 

- 柱線 - (F) SC1 鋼構內柱 (Element No. 41, 44) X 向無接續梁構件，將其設定為一根

桿件 (Member)，程式會自動抓對應的 Ly、Lz 有效長度等參數進行設計。 

- 由  Display 功能的 Design 表單，勾選 “Member” 查看指派為一根的設計桿件，

所有被小梁分割為數根 Elements 的梁構件會被指派為同一根桿件(Member)進行梁設

計。 

 

 

 

 

 

定義進行鋼構規範檢討的相關設計參數。 

 

(3) 由 Design > Steel Design > Design Code 指令設定鋼構設計規範。 

- 在 Design Code 選擇 “TWN-LSD96” 規範。(LSD：極限強度設計法) 
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(4) 由 Design > Steel Design > Bending Coefficient (Cb)… 指令設定由程式自動計算各構件

的彎矩修正係數。(當梁兩端受不相等端彎矩作用時，經使用修正係數 Cb 可得到更

合理的結果，預設值 Cb=1.0。) 

-  Select All 全選，勾選 “Calculate by Program”，點擊  指派。 

(由程式自動計算公式：Cb=1.75+1.05(M1/M2)+0.3(M1/M2)
2
 ≦ 2.3 ) 

 

 

定義進行 SRC 鋼骨鋼筋混凝土規範檢討的相關設計參數。 

 

(5) 選 Design > SRC Design > Design Code 指令設定 SRC 設計規範。 

- 在 Design Code 選擇 “TWN-SRC100 ” 規範。  

 

 
 

(6) 選 Design > SRC Design > Modify SRC Materials 指令設定鋼筋降伏強度。 

- 點選對話框內 ID:2 材料後在 Reinforcement Selection 選 Code : CNS560(RC) ; 

Grade of Main Rebar 選 “SD420” ; Grade of Sub-Rebar 選 “SD280” 定義主筋與

剪力筋的鋼筋降伏強度，按  設定。 

 

 

 



鋼構 SRC 複合構架設計範例 Rev.2 

 

 49

 

 
 

 

9. 鋼構設計 

設計參數指派完成後，執行鋼構斷面強度檢討。 

 

(1) 由主選單 Design > Steel Design > Steel Code Check… 功能開始進行鋼構桿件之設計。 
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 鋼構桿件設計結果對話框說明。 

 

鋼構設計(Code Checking)結果表： 

 

 

 

預設依 Property 排列

設計結果（也就是依

照 Section），並表示出

Critical Member 的設

計結果。 

可以切換為 Sorted by 

Member 檢視各桿件

檢討之結果及桿件設

計的詳細報表。 

展 

開  
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勾選「SEL」表格中任一根桿件後，按  查看簡圖形式的桿件詳細強度檢討資訊。 
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按  查看個別桿件檢討的詳細計算書。 
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按  選取所有桿件後，按  查看設計報表。 
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 挑選合適斷面的流程 

本例 RSB1 (RH 300x150x6.5x9) 進行 TWN-LSD96 斷面檢核強度不足，Combine Ratio > 1.0 需

要重新挑選合適斷面，再次進行結構分析與檢核。   

- 於 TWN-LSD96 Code Checking Result 對話框勾選 “NG” 斷面，按  開啟

Change Steel Properties 對話框。 

- 在 Limit Combined Ratio 輸入 0.7 to 0.9 範圍按  執行，依據需求

條件所挑選合適斷面將列於下方表。 

 

  

- 勾選  RH 244x175x7x11 按  改變斷面，將關閉對話框。 
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- 回到 TWN-LSD96 Code Checking Result 對話框，原 RSB1 斷面已由 RH 300x150x6.5x9 變更

為 RH 244x175x7x11，按  開啟 Update Changed Properties 對話框。 

- 勾選  SECT: 23 按 <‐ 更換斷面到分析模型。 

   

- 按  重新執行分析，程式將以新斷面進行分析。 

- 分析完成後，按  再次依據 TWN-LSD96 規範執行 Steel Code Checking 功能。 
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- 再次進行規範檢核後的 TWN-LSD96 Code Checking Result 對話框如下，變更後的 RSB1 斷面

RH 244x175x7x11 應力檢討 OK。 

 

    
變更斷面後檢討結果(OK)             變更斷面前檢討結果(NG) 
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11. SRC 柱斷面檢討 

先指定 SRC 柱設計斷面的鋼筋資訊後，再執行 SRC 柱斷面強度檢討。 

 

(1) 由主選單 Design > SRC Design > Modify SRC Column Section Data… 功能設定 SRC 柱

斷面的鋼筋配置。 

- 在 Section 列表的 SEL 勾選  “ID: 2” SSC1 柱，設定該斷面的鋼筋資訊。 

- 在 Reinforcing Main Bar 區域設定主筋配置：Rebar 為“ 12 – D25 ”、Number of Rows

為 “ 4 ” 排。 

- 在 Reinforcing Hoop 區域設定箍筋配置為 “ D13 – 0.15 m ” ，按  指派。 

   

 

(2) 由主選單 Design > SRC Design > SRC Code Check > Column Checking… 功能進行 SRC

柱桿件之斷面檢討。 
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 SRC 柱桿件斷面檢核結果對話框說明。 

 

SRC 柱規範檢核(Code Checking)結果表： 

 

 

 
 

 

預設依 Property 排列

設計結果（也就是依

照 Section），並表示出

Critical Member 的設

計結果。 

可以切換為 Sorted by 

Member 檢視各桿件

檢討之結果及桿件設

計的詳細報表。 

展 

開  
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勾選「SEL」表格中任一根桿件後，按  查看簡圖形式的桿件詳細強度檢討資訊。 
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按  查看個別桿件檢討的詳細計算書。 
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按  選取所有桿件後，按  查看設計報表。 
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12.  DShop 自動出圖 

Gen 的分析與設計執行完成後，匯出幾何模型資料與設計結果並儲存為 mgn 檔案，再由 DShop

程式匯入。 

 

(1) 由主選單 File > Export > Midas Drawing File… 匯出結果，儲存副檔名為 mgn 的檔案。 

        
(2) 點擊 Windows 桌面上的 midas DrawingShop 程式捷徑      或由程式集目錄開啟程式。 

- 由主選單 檔案 > 開啟新專案 開一個新的檔案。 

- 由主選單 檔案 > 匯入 > MIDAS/Gen 匯入步驟(1)的 mgn 檔。 

       

  

 

 
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 按  指定路徑，選取由步驟(1)所匯出的 mgn 檔案。 

  midas Gen 設計資料匯入方式選擇 “按斷面分類” 選項。 

- 匯入原則設定後，按 匯入檔案 對話框的  匯入，如下圖。 

 

 

此例題省略與出圖設定有關的功能介紹，介紹快速做成平/立面圖的方法。 

 

(3) 雙擊樹狀功能表 設計圖自動產生 功能或由主選單 構造圖 > 設計圖自動產生 選項執

行自動出圖功能。 

- 將開啟套圖框的對話框，預設為 A1 圖紙，圖面比例尺為 1/100，按  套圖框。 

 
 

模型視窗  

平/立面視景  

樹 

狀 

功 

能 

表  

樹 

狀 

功 

能 

表  
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套圖框後立即切換到 DShop 程式的 CAD 出圖模組，如上圖所示，模型視窗畫面將切換到

預設的 “版面設計#1” 視景的 CAD 圖面視窗，而左側則為 “設計圖列表” 與 “專案圖庫

列表”，下方為 “CAD 指令列” 輸入欄，指令操作同 AutoCAD 程式。 

 

(4) 展開左側設計圖列表的 平面圖、立面圖與構件列表 項目，將顯示各圖面細項，首先練習

佈置平面圖與立面圖於圖框內。 

- 雙擊 平面圖 > 2F 結構平面圖 項目，按預覽視窗的  ，指定 2F 結構平面

圖插入點，繪製於圖框內。 

- 接著再插入 RF 樓層的結構平面圖於圖框中。 

 

 

預覽視窗  

專案圖庫  

CAD 圖面視窗  

CAD 指令列 

設計圖列表  
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- 雙擊 立面圖 > 柱線 Y1 立面圖 項目，按預覽視窗的  ，指定柱線 Y1 立

面圖插入點，繪製於圖框內。 

     

 
 

(5) 雙擊 構件列表 > 柱斷面表(1) 項目，按構件列表型式視窗的  ，指定柱斷面

表的插入點，繪製於 CAD 圖面視窗內。 
 

 

 
 

 

 

預覽視窗  
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(6) 如圖中所示，到 “版面設計#1” 標籤按滑鼠右鍵，在功能表中選擇 “另存新檔” ，可將

圖檔儲存為 AutoCAD R14 到 AutoCAD 2004 版本的 DWG 與 DXF 檔案格式。 

     

 

 

 

 

 

 

 

13. B.O.M 檢料表 

最後介紹程式內建的檢料功能，對於 S+SRC 構架可依樓層與構件種類估算混凝土體積、鋼筋

量、模板面積等材料數量。鋼筋計算考慮搭接長度、伸展長度、鋼筋長度和標準彎鉤，檢料

表以 MS-Excel 檔案格式儲存，可選擇輸出中文格式或英文格式的材料表。 

 

(1) 如圖中所示，按 “模型視景” 標籤頁切換回前處理視窗介面，由主選單 工具 > B.O.M. 

材料表 選項，指定材料表輸出檔的儲存路徑與輸出選項(中/英文格式)，按  。 

 

 

 

 

  


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(2) 選擇開啟輸出的 MS-Excel 檔案，DShop 程式會直接以 MS-Excel 開啟報表，由 “總計” 與  

“鋼材” 的工作表檢視鋼筋、混凝土與鋼構材等數量計算的結果。 
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